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Introduction

Scripts Encryptor will be a handy tool for web developers seeking the way to protect their on-line content from
reverse engineering as well as from web bots collecting email addresses and other personal data. Improved Scripts
Encryptor can now work not only with JavaScript, but also with VBScript, ASP and HTML files that might contain
JavaScript and VBScript embedded blocks, and also with C/C++ source files. Unfortunately, HTML and JavaScript code
does not allow any substantial encryption the same way as when you compile source code into executable files or
when you save Flash movie in a shockwave format. The only way to protect HTML, JavaScript and VBScript scripts is
to employ obfuscation, i.e., scrambling of the contents.

There are many obfuscators available on the web that mostly use other scripts to do the scrambling. A big downside
of this approach is that to fully view such page, user's browser should support scripts and have them enabled, which
significantly limits number of web browsers that such encrypted page will be viewed on. Moreover, there's always a
possibility of a new security upgrade from Microsoft that will either show a virus warning, or won't completely open
your page that was encrypted using scripts with other obfuscators.

Scripts Encryptor does not use scripts to obfuscate HTML, JavaScript and VBScript. Instead it uses space stripping,
escape sequencing and Windows Script Encoder method to scramble web pages. Scrambled pages become fully clear
for web browsers but almost unreadable when viewed as HTML, or attempted to alter with an editor. To see what
happens with a web page after scrambling by Scripts Encryptor check samples section below, or watch the following
screencasts.

 
Screencasts

Watch the following screencasts where we walk you through the basic installation and operation of the Scripts
Encryptor:

 
Main Features

Scripts Encryptor provides the following options:

Obfuscation (scrambling) of JavaScript, JScript and VBScript standalone files.
Obfuscation of HTML and HTML-style files (like ASP) that might include JavaScript, JScript, VBScript embedded
blocks inside.
Encryption of JavaScript, JScript, VBScript data in a file or embedded in HTML page using Windows Script
Encoder method (emulation of screnc.exe by Microsoft)
Compression or "compacting" (reduction of size) of HTML/JScript/VBScript documents without obfuscation (to
downsize your bandwidth and increase loading time)
Flexible settings for obfuscation that allow to fine-tune level of scrambling.
Ability to preview obfuscated page and compare it with an original document using a Graphic User Interface.
Scrambling of C/C++/MFC source code files into solid chunks of code making them hard to view and edit.
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Checking of missing and/or extra semicolons in JavaScript, JScript code.
Support of international code pages and file encodings (overall Unicode support)
Ability to change code page and file encoding while saving in a file.
Ability to make a Unix-compatible file (with a single linefeed at the end of lines)
Compatible with Windows XP SP2, and IE6 popup blocker in general (so your previewed code is not blocked as
potentially dangerous)
Support for "Batch Conversion" of HTML/ASP, JavaScript, and VBScript files.
Command line support (so you can use it on your web server or as part of another software).

To learn more, please read on, or watch the screencasts.

 
Interface and Operation

Scripts Encryptor employs visual interface with simple navigational controls and two main windows to show the code
Before and After conversion:

To begin you have to either open an existing script file, or type or paste a script into the Before window. Scripts
Encryptor can work with the following script types:

HTML or HTML-type mark-up files, like ASP (that may include JavaScript/JScript/VBScript and CSS blocks - other scripting languages
are left intact and not obfuscated)
JavaScript/JScript and VBScript standalone files
C source code files
C++/MFC source code files.

Right after you open a file Scripts Encryptor will attempt to determine its type in the Script in 'Before' box. You can
also do so, or correct automatic setting manually. This selection is crucial for the conversion since all of the
abovementioned file types are converted differently.

Before making a conversion set the following options for it. First select the type of operation you'd like to perform:

Scramble - will obfuscate (scramble) code in the Before window. If it is HTML code containing JavaScript or
VBScript blocks they will be also obfuscated according to the selection. (Any unrecognized scripting languages will be left
without changes.)
Organize - will organize (de-scramble) code in the Before window making it easy to read and edit. (This feature is
available in the Premium version only. To learn more, go to Help -> Get Premium Version in the Encoder version.)
No Changes - will not alter the script in the Before window, but may allow applying of the other options.

Then select type of End of Lines in the respective section:
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CR+LF (\r\n) - stands for Carriage Return and Line Feed. Use this option to make a Microsoft-compatible script
file. (This option is mostly used for a script's readability.)
LF only (\n) - use this selection to make a Unix-compatible file. At this time many browsers understand this
encoding, so choosing it will not only make the code less readable but also smaller in size.
CR only (\r) - use this selection to convert all line-feeds to Carriage Return only symbols.

Then select HTML scrambling options in the HTML section:

Escape tags - when checked will make Scripts Encryptor to use escape sequences to scramble appropriate
HTML tags. Use this option to protect inline email addresses and web links from crawling robots collecting
information for spam distributors. (There are more options available for this selection - see Conversion Properties below.)
Escape text - when checked will make Scripts Encryptor to use escape sequences in the text within HTML code
that is located outside of tags. This option will render document almost unreadable by human eye while in
HTML-editing mode. (There are more options available for this selection - see Conversion Properties below.)
Random escape - when checked will make Scripts Encryptor to use escape sequences randomly for better
obfuscation. We recommend keeping this option on. (There are more options available for this selection - see Conversion
Properties below.)

Then select JavaScript/VBScript scrambling options in the Script section:

Encode script - when checked will make Scripts Encryptor to apply Windows Script Encoder method to
JavaScript and VBScript blocks within current HTML/ASP file, or to the whole document if it's opened as
JavaScript or VBScript. (This option employs emulation of encoding of JScript/VBScript scripts originally
performed by Microsoft® Script Encoder (screnc.exe), Microsoft® Corporation.) WARNING: Use this option with caution as
although encrypted code looks visibly safe it can be easily decoded. Besides that this encryption is currently recognized only by Microsoft Internet
Explorer 5.0 and later browsers! Use it only to protect your server-side scripts. 
To prevent a certain code block from being encoded use SENoEnc="1" command in a <SCRIPT> tag as shown in
this example:
  <SCRIPT language=JavaScript type=text/javascript SENoEnc=1> ... </SCRIPT>
Escape Quotes - when checked will make Scripts Encryptor to use escape sequences in JavaScript quotes. This
will dramatically decrease readability of your code. (There are more options available for this selection - see Conversion Properties
below.)
Escape Code - when checked will make Scripts Encryptor to use escape sequences in JavaScript code
statements. This will dramatically decrease readability of your code. (There are more options available for this selection - see
Conversion Properties below.)
Random escape (for JavaScript) - when checked will make Scripts Encryptor to use escape sequences randomly
for better obfuscation. We recommend keeping this option on. (There are more options available for this selection - see
Conversion Properties below.)
Random capping (for VBScript) - when checked will make Scripts Encryptor to capitalize variable and method
names in the VBScript for better obfuscation. We recommend keeping this option on. (There are more options available
for this selection - see Conversion Properties below.)
Add Semicolons (for JavaScript) - when checked will make Scripts Encryptor to add required semicolons at the
end of script lines to ensure better scrambling achieved by stripping spaces between code lines, which might not
be possible because of omitted semicolons. WARNING: Try to put semicolons required by language syntax at the end of code lines
while programming, or always check semicolons added automatically by Scripts Encryptor (they will be marked in the After window after
conversion is done).
Add Colons (for VBScript) - when checked will make Scripts Encryptor to add colons at the end of lines in the
VBScript script to make it appear as a solid line of code.
Remove Semicolons - when checked will make Scripts Encryptor to remove extra semicolons in the script that
are not required for scrambling. WARNING: Always check semicolons removed automatically by Scripts Encryptor (they will be marked
in the Before window after conversion is done).

When conversion options are set you may now click Convert button to perform conversion. Depending on the size of
the script, converted code will then appear in the After window. It will include the color coding for better readability. If
you opted to add or remove (semi-)colons from JavaScript/VBScript blocks they will be also marked in yellow in the
After or Before windows respectively.

 
Controls and Navigation

Scripts Encryptor has all controls located on its toolbar. The same controls (commands) are also available from its
main menu:

Clear 'Before' Window - opens a new document and clears Before window (use it to insert script into Before
window manually)
 
Open - opens a window that allows you to select a file for conversion.
You can also open the file by dragging its icon into the Before window, or by selecting it from the File menu, recently opened section.
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Save 'After' Window - opens a window that allows you to save converted document from the After window
into a file.
You can select the following options in the Save As window:

File Encoding - allows you to specify file encoding used to save file.
Save for offline viewing - option used for compatibility with Windows XP SP2, when checked saves HTML
file for offline viewing. This prevents Internet Explorer from showing warning messages.
 

Cut - cuts selected text from Before or After window into the Windows clipboard. (To determine which window is currently
active look at the title on top of it. When it's bold, it means that the window has keyboard focus. To switch between Before and After windows
click its title, or press Alt+1 or Alt+2 shortcut keys.)
 
Copy - copies selected text from Before or After window into the Windows clipboard. (To determine which window is
currently active look at the title on top of it. When it's bold, it means that the window has keyboard focus. To switch between Before and After
windows click its title, or press Alt+1 or Alt+2 shortcut keys.)
 
Paste - inserts text from the Windows clipboard into Before or After window. (To determine which window is currently
active look at the title on top of it. When it's bold, it means that the window has keyboard focus. To switch between Before and After windows
click its title, or press Alt+1 or Alt+2 shortcut keys.)
 
Erase - erases selected text from Before or After window. (To determine which window is currently active look at the title on
top of it. When it's bold, it means that the window has keyboard focus. To switch between Before and After windows click its title, or press Alt+1
or Alt+2 shortcut keys.)
 
Select All - selects all the text in the Before or After window, depending on which one is currently selected.
 
Move to 'Before' - copies code from the After window into the Before window. This option might be used for
recurring conversion due to complexity of the script.
 
Undo - undoes code changes in the Before or After window. This option is now multi-level enabling you to
revert to previous state of the script.
 
Redo - rolls back changes undone by undo option.
 
Encoding - shows the window to select File Encoding and Code Page that will be used to save script in the
After window into a file. Use this option to set conversion type of HTML script to a preferred code page and/or
file encoding. Read more here. (This feature is mostly used for non-English pages and alphabets.)
 
Find - shows the window to perform text search in the Before or After window.
 
Next Semicolon - if semicolons were added or removed from the Before or After window, this option cycles
through them by highlighting added or removed semicolons in a sequence.
 
Previous Semicolon - if semicolons were added or removed from the Before or After window, this option cycles
through them by highlighting added or removed semicolons in a sequence.
 
Locator - translates selected code block from one window to another. This option might be useful for debugging
your code: for instance, you may want to select a questionable part of the code in Before window and click this
button. It will find selected code in the After window. It also works the opposite way. INFORMATION: Locator should not
be used for determining exact correlation between original and converted scripts - it only hints location of selected segment.
 
Preview 'Before' Window - previews the script from the Before window in the web browser. Using this option,
you don't have to save contents of the Before window to see how the original script works. Using a drop-down
menu on the side of this button, you can select and customize which browsers should be used to open the script
from the Before window. (Microsoft Internet Explorer web browser is used by default for HTML, and a built-in scripting host for JavaScript
and VBScript scripts.)
 
Preview 'After' Window - previews the script from the After window in the web browser. Using this option,
you don't have to save contents of the After window to see the results of conversion. Press this button to open
the converted script in a web browser and you will immediately see if there were any errors during conversion.
Using a drop-down menu on the side of this button, you can select and customize which browsers should be
used to open the script from the After window. (Microsoft Internet Explorer web browser is used by default for HTML, and a built-in
scripting host for JavaScript and VBScript scripts.)
 
Conversion Properties - opens the window to set additional conversion options:
 

Keep comment tags when scrambling - if checked does not discard HTML comment tags (i.e., tags like <!-
- ... -->) when scrambling. In many cases you won't need them to be included in the production,
scrambled file ready for posting online. But, in rare instances some scripts on the page might require
comment tags to mark certain code parts. As a script developer you should know whether to use this



option, or not. (When checked reduces the resulting code size.)
Use comment tags on script blocks if allowed - if checked, puts the comment tags (i.e., tags like <!-- ... -
->) into the embedded script blocks. If on, will increase the code size and the readability of the script.
But, these tags might be still required by older browsers to process your HTML/ASP document correctly.
 
Allow applying Windows Script Encoding to - option allows you to select which script blocks should be
affected by the Windows Script Encoding mechanism. If set to "All JavaScript/JScript/VBScript blocks" it
will affect all JavaScript/VBScript blocks within HTML/ASP document. You also have an option to select
certain variations of JavaScript/VBScript language in the box below by specifying them in a comma-
separated list.
 
Allow selective scrambling of URLs - if checked escaping of links in the HTML document is permitted while
scrambling. It is recommended that you keep this option checked as it provides protection of your web
links against web robots collecting email addresses.
 
Don't use short hex escape sequences in URLs (i.e., %XX) - if checked will prevent the use of the
hexadecimal escape sequences in links in the HTML/ASP document. Example of such symbol is '%20'
standing for space. (Some older web browsers, including Netscape Navigator, do not interpret these characters correctly when they
are present in web links. There also might be an issue with some web servers misinterpreting these escape sequences in the tail of
URLs.)
 
Default Scripting Language (ASP) - this option allows you to specify which language (VBScript or JScript)
will be used by default while scrambling an ASP script, if one is not specified in the ASP script itself. (A
default language is usually specified by the @language directive at the beginning of the ASP script.)
 
Add/update @language directive when encoding scripts (ASP) - check this option if the @language
directive should be updated automatically while encoding an ASP script.
 
Random Escaping/Capping Threshold - this slider lets you select preferred random escaping (for
JavaScript) or capping (for VBScript) threshold value. Random escaping/capping is used to obfuscate
HTML/ASP, JavaScript and VBScript code. If you move this slider towards the left (Less) side, this will
mean inclusion of less escaped/capped symbols in the scrambled code (thus reducing file size but
increasing readability); if you move the slider towards right (More) side, this will mean inclusion of more
escaped/capped symbols (thus increasing the file size but decreasing the readability.)
 
Always escape non-ASCII characters in JavaScript - check this option to allow escaping of non-ASCII
symbols in JavaScript scripts. (Using this option will make Scripts Encryptor to use longer escape sequences on any non-ASCII
symbol.)
 
Don't change file names when saving converted data - this option is provided for compatibility with the
older version of the Scripts Encryptor. It is strongly recommended to keep this option unchecked. By
keeping it unchecked, the Scripts Encryptor will add (scrambled) or (encoded) to the end of a file name
when saving a converted script. 
IMPORTANT: Never write over an original file after performing an automatic conversion with the Scripts Encryptor!
 
Verbose mode, i.e. show info and warning messages after conversion - when checked will make Scripts
Encryptor to show pop-up dialog messages with the results of each script conversion. (This option can be also
canceled from any of the pop-up messages themselves.)
 
Show warning before previewing JavaScript or VBScript - check this option to make Scripts Encryptor to
show a warning before running a JavaScript or a VBScript script. (Use this option in case you do not know the origins
of a script you might be loading into the Scripts Encryptor.)
 
Convert script automatically upon opening - if checked, will make Scripts Encryptor to convert a script as
soon as you open it. Otherwise, you'll need to click "Convert" button to begin a conversion. (This option has no
effect in unregistered demo copy of the Scripts Encryptor. In that case, the Scripts Encryptor always waits for the "Convert" button to be
pressed before beginning the conversion.)

The status bar (located at the bottom of the Script Encryptor's window) shows the following information:

First section may contain description of a button or a command currently pointed at by the mouse cursor:

 
The first section may also display the last syntax error that was found in the script in the Before window during
conversion:



INFO: Double-click on this section of the status bar to place the cursor at the location reported in the error message.
 
Second section contains line and column numbers that specify the location of the keyboard cursor in the
currently active window:

 
Third section contains current file encoding that will be used to save the contents of the After window to a file:

INFO: To change it double-click it.
 
Fourth section contains current code page name that will be used to save the contents of the After window to a
file:

INFO: To change it double-click it.
 
Next sections show the keyboard status, such as Caps Lock, Num Lock:

 

 
International Settings

Scripts Encryptor is a Unicode-based program, now supporting many file encodings and international code pages. It
will automatically detect the code page and file encoding when you open a script. To change any of these settings go
to File -> Encoding. You will have an option for the following file encodings:

ANSII - older encoding from American National Standards Institute using one byte per character. (This encoding
is used by default for all English pages as it produces the most size-efficient files. But, it might not contain
enough symbols to save non-English pages.)
 
Unicode - encoding using two bytes per character, which allows many international characters to be saved
without distortion. The downside of using this encoding is that it significantly increases the file size needed to
store and transmit a page.
 
Unicode (Big-endian) - the same as Unicode but with reversed byte sequence.
 
UTF-8 - encoding that employs a mix of ANSI and multi-byte encodings. Might be the most effective for saving
international web pages since it uses one byte encoding for English characters and multi-byte encoding for any
others.

Besides that Scripts Encryptor allows you to select the code page that will be used in HTML documents (for
conversion) when saving data to a file. A complete list of supported code pages might be found in the corresponding
box in the File Encoding & Code Page window.

 
Command Line Operation

Scripts Encryptor can be run from the Windows command line without involving the visual editor. This could be useful
if you prefer to run Scripts Encryptor on a background as an integral part of another software, or on a web server. It
can perform the same tasks as those available in its normal (GUI) operation. For more information go to Help ->
Command Line Help from the main menu in Scripts Encryptor, or click here to read the command line operation
manual.

 
Batch Conversion Using Command Line

Scripts Encryptor can also do a batch conversion of HTML/ASP, JavaScript/VBScript, C/C++ files from a single or
nested folders using the command line options. Also watch the screencasts for an example of the batch conversion.

 
Reverse Engineering Protection Policy
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Scripts Encryptor is now distributed in the "Encoder" package, which allows every possible obfuscation (scrambling) of
HTML/ASP, JavaScript/VBScript, C, C++ code with added options. In the same token, we removed the "de-scrambling"
capabilities from the Encoder version.

For those who would like to receive a complete set of features of the Scripts Encryptor (including a full decryption, or
de-scrambling) we also offer the Premium Version. (To learn more go to Help -> Get Premium Version from the main
menu in the Scripts Encryptor - Encoder.)

We believe that these measures will discourage reverse engineering attempts using Scripts Encryptor.

 
Obfuscation Samples

To better understand the way Scripts Encryptor can obfuscate (scramble) and de-scramble source code look at some
samples produced by it. Click here to view.

 
Bug Report and Feedback

Please let us know about any glitches that you may find in Scripts Encryptor, also feel free to post your comments and
suggestions through the feedback. This will improve any future versions of this software. Plus if we find your
report/suggestion useful we will give you a new improved version absolutely free of charge.

Thank you for choosing the Scripts Encryptor!

  Check other latest software FREE to download!

Report Errors and Glitches (IMPORTANT: Include detailed description of the glitch and the part of the script you're referring to.)
Send Comment/Suggestion
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